	Instructors Guide for Computer Operating Systems
	



All desktop computers have operating systems. The most common are the Windows family of operating systems developed by Microsoft, the Macintosh operating systems developed by Apple and the UNIX family of operating systems (which have been developed by a whole history of individuals, corporations and collaborators). There are hundreds of other operating systems available for special-purpose applications, including specializations for mainframes, robotics, manufacturing, real-time control systems and so on.

What an Operating System Does

The first task, managing the hardware and software resources, is very important, as various programs and input methods compete for the attention of the central processing unit (CPU) and demand memory, storage and input/output (I/O) bandwidth for their own purposes. In this capacity it is making sure that each application gets the necessary resources while working with all the other applications, as well as utilizing the possibly limited capacity of the system to the greatest good of all the users and applications. 

The second task, providing a consistent application interface, is especially important if there is to be more than one of a particular type of computer using the operating system, or if the hardware making up the computer is ever open to change. A consistent application program interface (API) allows a software developer to write an application on one computer and have a high level of confidence that it will run on another computer of the same type, even if the amount of memory or the quantity of storage is different on the two machines.
Definition

An operating system (OS) is the software that manages the sharing of the resources of a computer and provides programmers with an interface used to access those resources. An operating system processes system data and user input, and responds by allocating and managing tasks and internal system resources as a service to users and programs of the system. At the foundation of all system software, an operating system performs basic tasks such as controlling and allocating memory, prioritizing system requests, controlling input and output devices, facilitating computer networking and managing files.

Most operating systems come with an application that provides an interface for managing the operating system. The operating system forms a platform for other software
Microsoft Windows
Windows XP is a line of operating systems developed by Microsoft for use on general-purpose computer systems, including home and business desktops, notebook computers, and media centers. The name "XP" stands for eXPerience. It was codenamed "Whistler", after Whistler, British Columbia, as many Microsoft employees skied at the Whistler-Blackcomb ski resort during its development. Windows XP is the successor to both Windows 2000 Professional and Windows Me, and is the first consumer-oriented operating system produced by Microsoft to be built on the Windows NT kernel (version 5.1) and architecture. Windows XP was first released on October 25, 2001, and over 400 million copies were in use in January 2006. It is succeeded by Windows Vista, which was released to volume license customers on November 8, 2006 and worldwide to the general public on January 30, 2007. Microsoft has now shipped 88 million copies of the operating system, almost double the number of copies of XP in the same amount of time at its launch.
Vista User interface
Most modern computer systems contain Graphical User Interfaces

Since Vista represents the future of the desktop operating system it will be used throughout the remainder of this module to demonstrate the features that users need to understand to become proficient in the use of a modern desktop computer today.

Vista Desktop

Desktop provides an area for creating shortcuts to frequently used applications, systems utilities, folders, files, and other items. By default the only item on the desktop is the Recycle Bin. 
Start Menu

Start Menu is a two-column menu that provides access to your applications, file management programs, and computer and network management programs. You can use the Start menu to get help, search for files, open a command prompt, and shut down of the computer. To display the Start button click the Windows Button or press CTRL+ESC. 

Using the Start menu
The top of the Start Menu contains shortcuts to programs that have been pinned to the Start menu. 

Below the pinned items are buttons that provide access to your most frequently used programs. Windows monitors which program your use most often and adds them to the list automatically. You can specify how many items, up to thirty, are displayed in the properties setting for the Start Menu. Select Customize Start menu button of the Taskbar and Star Menu Properties page.
Start button to display the Start menu of all installed programs.

The right side of the menu contains three sections.

The Top Section provides access to folder used to store files on your computer

The Middle section provides access to network places and to programs used to manage your computer.

The Bottom section provides access to the Control Panel where you manage system and hardware settings and access Windows Help.


Opening a Program
Click the start button

If the program is on the left click it to run, if the program is not listed click All Programs to open it or a submenu where you can find the program.

Click the program to open it.

From the Start menu you can select both programs and folders 

Click the Start button to open the Start menu

Click your user name to open your personal folder

Click Documents to open the Documents folder

Click Computer to open the Computer folder
Vista Files and Folders
Parts of the file and folder window
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Using a Folder Window

To navigate the folder hierarchy

Open the folder

The Address Bar displays the path you’re taking into the folder hierarchy. The buttons allow you to navigate forward and backward through the folder hierarchy.
Click a folder in the Address Bar to return to it or use the Forward and Back buttons to move up and down the hierarchy.

Clicking a link in the Favorite Links will open the folder.
Create a File

Right-click to display a shortcut menu

Click New

Select from the submenu the type of file you want to create.
To rename a file select the current filename and key in the new name.

Folder and File naming conventions

Descriptive name identifies content

May use up to 260 characters

May not use \ /? : * “ > < |
File extension are found at the end of the file name after the period. 

.txt
Text

.rtf
Rich text format

.doc .docx
MS Word

.bmp
Bitmap image

.html
Web page-Hypertext markup

.pdf
Adobe document

.xls
MS Excel Workbook

.ppt
MS Power Point

Open a File

Opening a file ; Double click the file icon or Right click the file icon and click Open on the shortcut menu. 

Close a File

Click the Close button in the upper right corner of the program window


OR

Click File on the window’s menu bar and click Close or Exit on the File menu
Enter Text in a File
Key text into the file

Press the Enter key to start a new line

Press the Backspace key to delete the character to the left

Press the Delete key to delete the character to the right

Drag to select existing text

Key new text to replace existing text
To edit text you use the Backspace key to delete the character to the left

Use the Delete key to delete the character to right.

Drag to select text and key new text to replace existing text.

Save a File
Click File on the window’s menu bar
Click Save on the File menu
Save a File with a Different Name
Click File on the window’s menu bar
Click Save As on the File menu
Save As Command
Use Save As to

Save a file with a new name

Save a file in a new storage location

Save a file in a different file type
Print a File
Right-click the file icon

Click Print on the shortcut menu
Delete a file or folder

Right click on the file or folder icon

Click Delete from the shortcut menu 
When deleting an item click the Yes to confirm the deletion.
Recycle Bin

Double-click the Recycle Bin icon on the desktop

Restore a Deleted Folder or File
Open the Recycle Bin

Select the item you want to restore

Click the Restore this item button on the Recycle Bin window’s toolbar
Restore Multiple Deleted Folders or Files
Open the Recycle Bin

Select the items you want to restore

Click the Restore this item button on the Recycle Bin window’s toolbar

Permanently Delete an Item
Open the Recycle Bin

Right-click the item to delete

Click Delete on the shortcut menu

Confirm the Delete by clicking YES in the conformation dialog box
Permanently Delete All Items
Open the Recycle Bin.
Click the Empty the Recycle Bin button on the Recycle Bin window’s toolbar.
Click yes in the confirmation dialog box.
Navigating Through Windows
Browse Through Recently Opened Windows.
Click the Back button to display the previously viewed window.
Click the Forward button to display the window that was displayed before you clicked the Back button.
Click the Recent Pages dropdown arrow to display a list of locations you have viewed during the current session.
Click a location on the Recent Pages dropdown menu to display it.
Click a location in the Favorite Links list to display the Navigation Pane.
Using the Address Bar
The Address bar displays your current location as a series of links separated by arrows.
Click a link in the address bar to make it the current location.
The text in the Address bar changes to display the path to the current folder.
Key the name of the location OR Key the path to the location.

Change the Icon Size

Open a folder window

Click the dropdown arrow on the Views button.

Click the view option you want to use from the available options, Large to Details. Note that the selector is a slider that allows you to adjust the size and shape of the icons used in the window.

Display or Hide Details

Details display in columns across the width of the File list
Right-click a column heading to display a list of common details

A checkmark indicates that a detail is displayed
Click More... to open the Choose Details dialog box to select from a lengthy list of available details

Click a checked checkbox to deselect the detail.

Sort the File list by the detail in any column heading

Click a column heading to sort items by that detail

An arrowhead displays on the column heading that is used for the sort

Click the heading again to reverse the sort order
Group Details

Group items to organize them into smaller, more manageable lists

Group items by any detail

Groups may be alphabetical, numerical, or chronological depending on the detail

Rest the mouse pointer on the column heading by which you want to group

A dropdown arrow displays
Click the dropdown arrow to display a menu of options

Click Group on the menu and items are grouped by the selected detail.

Stack items to display related files as a single icon

Rest the mouse pointer on the column heading by which you want to stack

Click the dropdown arrow Click Stack by Name on the menu.

Change a Folder Layout
Click the Organize button

Click Layout to display a submenu of available panes and the menu bar

On the submenu, click to select or deselect any element 

A blue rectangle highlights elements that are already displayed
Setting General Folder Options

Set general folder options to customize the display of all folder windows 

Choose Windows classic folders to hide the Preview and Details panes

Choose to open new folders in separate windows

Choose to open items with a single click
To set folder options Click the Organize button

Click Folder and Search Options

The Folder Options dialog box displays
Click to select options

Click OK

Click the Restore Defaults button to revert to the default general folder options.

Setting Advanced Folder Options

Set advanced folder options to customize and control the information displayed in all folder windows 

Show hidden files and folders

Show protected operating system files

Show file extensions

Click the Organize button

Click Folder and Search Options

The Folder Options dialog box displays

Click the View tab
Click to select or deselect Advanced settings

Click OK

Click the Restore Defaults button to revert to the default advanced folder options

Adding and Removing Favorite Links in the Folder Window

Drag any folder from the File list to the Favorite Links list

It will be available in all folder windows
To remove a Favorite Link

Right-click the link

Click Remove Link on the shortcut menu

Confirm the deletion.

Preview Picture Files in a Vista Folder

Picture files store graphics

Photos

Drawings

The default view for pictures in a Windows Vista folder window is Large Icons.

Display the Preview pane to preview an image in other views

Select the file to preview
Double-click a picture file in the File list to preview it using a graphics viewing program

Windows Photo Gallery comes with Windows Vista.

Click the Slide Show button on a window’s toolbar to display the pictures in the current folder as a Photo Gallery slide show
Pictures are sized to fill the desktop

Pictures advance at a medium speed

Pictures loop in consecutive order.

Use the shortcut menu to change Slide Show options from the slide show.
Change the automatic advancement speed

Shuffle the pictures in random order

Manually stop, play, pause, or advance pictures

Preview Audio and Video Files in a Vista Folder
Audio files store sound

Video files store video, animation, and sound

Double-click an audio or video file to preview it using a media player program

Windows Media Player comes with Windows Vista

Use the Preview pane to preview an audio file in a Windows Vista folder.

Use buttons on the controller toolbar to preview audio and video files.

Customize Folders

You can store any type of file in any folder

Apply a folder template to customize a folder for storing a specific type of file

Right-click the folder icon

Click Properties to open the folder’s Properties dialog box

Click the Customize tab then click the
Use this folder type as a template
dropdown arrow.
To customize folders for specific file types click the template to apply

· Documents

· Pictures and Videos

· Music Details

· Music Icons
Import Pictures
Import pictures from a digital camera so you can view and edit them with Windows Vista

Connect the camera to the computer and The AutoPlay dialog box displays. Click Import Pictures.

In the Importing Pictures and Video dialog box, key a tag

Click Import

Windows Vista uses the tag to name the files and the folder where the files are stored

Windows Vista also adds the tag to the details for each imported file

Use the Print Pictures Wizard to print a picture directly from Windows Vista.

Print a Picture

Set up the printer for use

Connect the printer to the computer

Load the printer with paper

Use photo-quality paper for a photo-quality print

Right-click the file to print

Click Print on the shortcut menu

The Print Pictures Wizard starts, in the wizard select a printer

Select a paper size

Select a paper type.

Then Click a layout

Enter the number of copies

Click Print.

Burn Files to a CD or DVD
Burn files to a CD or DVD so you can use them on a different computer

You may be able to play a CD you create with Windows Vista on a CD player

You may be able to play a DVD you create with Windows Vista on a DVD player
Note: You must have a recorder drive

You must have writeable discs

Insert a writeable disc in the recorder drive

Insert CDs in a CD drive

Insert DVDs in a DVD drive.

Click Burn files to disc in the AutoPlay dialog box

Key a title for the disc

Click Next

Windows Vista formats the disc, to copy to the drive Drag the files from their source location into the disc’s folder window


OR

Select the files in the source location and click the Burn button on the window’s toolbar.

Eject the disc from the drive

Windows Vista closes the CD or DVD to complete the process which will allow you to use the disk on other computers, and ejects the disc.

Using the Search Box

Use Windows Vista’s search tools to find stored items

Find files

Find folders

Find email

Find programs

Key search text in a search box on the Start menu, in a folder window, or in a Search folder

Matching items will display in a search results list.

Search from the Start Menu

Search from the Start menu if

You do not know where an item is stored

You want to find a program

Click the Start button to display the Start menu

Key search text in the search box.

Windows Vista searches indexed locations to find items that have the search text in the filename, file content, or file properties

Matching items display in the Search Results list.
Searching in Folders

Used when you know the item you need is in that folder or one of its subfolders or you want to use the Search pane to select a category to search.

Windows Vista searches the current folder and its subfolders to find items that have the search text in the filename, file content, or file properties

Matching items display in the search results list.

Using Wildcard Characters

Use wildcard characters to find a wider range of matching items

?  Can be used in place of any single character

*  Can be used in place of one or more characters.

Using a Search Folder
Use a Search folder if you do not know where an item is stored or you want to use the Search pane to select a category to search.

The search folder begins with a blank Search Folder. Key search text in the search box

Windows Vista searches all indexed locations to find matching items

Use the Search pane to filter the search by category

Use wildcard characters if necessary.

A Search folder is a virtual folder

It is a temporary location in your computer’s memory and is used only to organize and display the results of the current search.
You can narrow down a search using Boolean filters.
· AND finds items that contain both words

· OR finds items that contain either word

· NOT finds items that contain the first word, but not the second 

Using an Advanced Search

Use an advanced search to filter by text, by criteria other than text, or by a combination of criteria

· Filter by date

· Filter by size

· Filter by location

Display the Search pane in any folder window

Click the Advanced Search expand arrow to display the Advanced Search options.
Saving a Search

Save time and effort by saving a search to use again

Create and run a search

Click the Save Search button on the search result window’s toolbar

The Save As dialog box displays, Key a name for the search in the Filename box

Click Save

The Search is saved in Searches folder.

Reusing a Saved Search

Use a saved search any time you need it

Click Searches in the Favorite Links list or
Open your personal folder

Double-click Searches in the File list

The Searches folder opens to display a list of saved searches

Setting Search Options

Set Search options on the Search tab of the Folder Options dialog box

Click the Search Tools button on a window’s toolbar

Click Search options on the dropdown menu

The Search tab of the Folder Options dialog box displays.

Click to select or deselect options

Click OK.

Next specify what to search

· Indexed locations for filenames and contents

· Non-indexed locations for filenames only

· All locations for filenames and contents

· All locations for filenames only
Then specify how to search

· Search subfolders of the current folder

· Find partial matches

· Use natural language speech

· Do not use the index
Opening Multiple Windows in Vista
You can open an unlimited number of windows at the same time.

Arranging Multiple Windows

Right-click a blank area of the taskbar

Click an arrangement select form the options
· Cascade Windows

· Show Windows Stacked

· Show Windows Side by Side

Windows Aero Option uses the Windows Key and Tab.
Changing the Active Window

Only one window can be active

To make a window active

Click anywhere in the window

Click the window’s taskbar button

Use Alt + Tab switching.

Windows Help and Support

Windows Help and Support is a series of linked pages that you can use like browsing the web.

In Windows Help and Support you can find

· Information about Windows Vista features

· Steps for accomplishing specific tasks

· Links to information on the Internet

To open the Help and Support Window

· Click the Start button

· Click Help and Support
· Use the links on the home page to go to a general category
Use links on the category page to locate information

· Links that have question mark icons go to specific help topics

· Links that have book icons go to subtopics
The color of text on a Windows Help and Support page identifies types of links

· Blue text links to another topic or to a specific task

· Green text links to a definition

· Violet text indicates a link that has been used at least once
At any time, click the Windows Help and Support home page button to get back to the home page.

Shutting Down Options in Windows Vista

There are different ways to end your Windows Vista session

· Switch User

· Lock the computer
· Click the Start button
· Click the Lock this Computer button
· Lock your computer to keep unauthorized users from accessing your system while you are away
· To unlock your computer, follow your standard login procedure
· Log off
· Click the Start button
· Click the arrow to the right of the Lock this Computer button
· Click Log Off
· Restart

· Enter sleep mode
· Click the Start button
· Click the Sleep button
· Use sleep mode to save your data and conserve power when you are away
· To wake from sleep mode, press the power button on your computer, press any key, or move the input device
· Shut Down the computer
· Click the Start button

· Click the arrow to the right of the Lock this Computer button

· Click Shut Down

· Turn off components, such as the monitor

